12d Model Course Notes

These notes were prepared by Sonia Robinson and may be copied by an individual for personal use but MAY NOT be distributed by any business or individual other than Extra Dimension Solution (EXDS) Pty Ltd.

Disclaimer

These notes MAY NOT be used as the basis for a course of formal instruction without written permission from Extra Dimension Solution (EXDS) Limited.

Extra Dimension Solution (EXDS) Pty Ltd is an authorised distributor of ‘12d Model’. Disclaimer 12d Model is supplied without any express or implied warranties whatsoever.

No warranty of fitness for a particular purpose is offered.
No liabilities in respect of engineering details and quantities produced by 12d Model are accepted.

Finally, these notes have benefited from the feedback of others, and so indirectly have you. If you felt that any part of these notes were difficult to understand, not clear, or would benefit from more examples, or if you have any other comments at all, the please let EXDS know. Please email the Support Team at support@exds.com.au

These course notes are available as a download from www.exds.com.au

Sonia Robinson – April 2013
Copyright 2013 © Extra Dimension Solution (EXDS) Pty Ltd
All rights reserved
# Table of Contents

- **Introduction to 12d Model Data Setup** .................................................................................. 5
- **INSTALL TRAINING DATA** ................................................................................................... 5
- **The Big Picture – Road Design in 12d Model** ........................................................................ 6
- **ROAD DESIGN IN 12D MODEL** ............................................................................................ 6
- **Project Creation and Management** ......................................................................................... 7
- **CREATE A NEW PROJECT** ...................................................................................................... 7
- **Importing Survey Data into 12d Model** .................................................................................. 8
- **NATURAL SURFACE TIN (TRIANGULATED IRREGULAR NETWORK)** .............................. 8
- **LOADING DATA – READING DATA INTO 12D MODEL** ....................................................... 9
- **Checking the Survey Data for Elevations, and Crossing Breaklines** .................................. 13
- **CHECKING DATA** ............................................................................................................... 13
- **ELEVATIONS CHECK** ............................................................................................................ 13
- **NULLING HEIGHTS** .............................................................................................................. 14
- **CHECKING BREAKLINES** .................................................................................................... 15
- **Triangulating the Survey Data for an Existing Surface TIN, Editing the TIN and Nulling Triangles** ................................................................................................................................... 17
- **CREATE A TIN (TRIANGULATED IRREGULAR NETWORK)** ................................................ 17
- **EDITING THE TIN** ................................................................................................................ 20
- **NULLING TRIANGLES BY POINTS** ..................................................................................... 21
- **RESTING TRIANGLES THAT HAVE BEEN NULLED** ............................................................. 22
- **NULLING TRIANGLES BY STRINGS** .................................................................................... 23
- **ADD A BOUNDARY AROUND THE TIN** ................................................................................. 24
- **Creating a Design Cross Section – Template** .................................................................... 25
- **TYPICAL CROSS SECTION FOR A ROAD DESIGN** ............................................................. 25
- **CREATING A TEMPLATE – CROSS SECTION FOR A ROAD DESIGN** ........................... 26
- **CREATE THE FIXED PART OF THE TEMPLATE** .................................................................. 27
- **CREATE THE CUT PART OF THE TEMPLATE** ..................................................................... 28
- **CREATE THE FILL PART OF THE TEMPLATE** .................................................................... 29
- **CREATE THE FINAL CUT / FILL PART OF THE TEMPLATE** ................................................ 30
- **Creating a Control String – The Road Centreline** ............................................................... 31
- **THE CONTROL STRING** ..................................................................................................... 31
- **CREATE A SUPER ALIGNMENT STRING** ........................................................................... 31
- **OPENING THE SUPER ALIGNMENT TOOLBAR** ................................................................. 32
- **CREATE A SUPER ALIGNMENT** ......................................................................................... 32
- **THE SUPER ALIGNMENT EDITOR** .................................................................................... 33
- **THE SUPER ALIGNMENT EDITOR – IP METHOD** ............................................................ 34
- **THE SUPER ALIGNMENT TOOLBAR** ................................................................................ 42

---

**Extra Dimension Solutions**

**Basic Civil Design – Part 1**
THE SUPER ALIGNMENT EDITOR – HORIZONTAL DESIGN ................................................................. 43
THE SUPER ALIGNMENT EDITOR – VERTICAL DESIGN.......................................................... 49

Combining the TIN, Control String and Template in the APPLY Function .................................. 54

APPLY PANEL .......................................................................................................................... 54
WHAT IS HAPPENING – UNDERSTANDING THE APPLY FUNCTION ........................................... 62

12d Model Perspective View and driving down the road ............................................................... 63

CREATE THE PERSPECTIVE VIEW ........................................................................................................ 63

Plan Plotting ........................................................................................................................................ 64

ADDITIONAL PLAN INFORMATION TO CREATE ............................................................................ 64
TADPOLES / BATTER SLOPE LINES ................................................................................................. 64
LABEL CENTRELINE CHAINAGES ........................................................................................................ 66
CENTRELINE GEOMETRY SETOUT INFORMATION – TABULATION .................................................. 69
CENTRELINE GEOMETRY SETOUT INFORMATION – TABULATE IPS .................................................. 70
QUICK SHEET PLOT .......................................................................................................................... 72
COORDINATED CADD PLAN OUTPUT – AUTOCAD ..................................................................... 74
COORDINATED CADD PLAN OUTPUT – MICROSTATION ................................................................. 75

Long Section Plotting ...................................................................................................................... 76
LONG SECTION PLOTTING .................................................................................................................... 76

Cross Section Plotting ...................................................................................................................... 82
CROSS SECTION PLOTTING .................................................................................................................. 82

Final Design Changes ....................................................................................................................... 84
FINAL DESIGN CHANGES .................................................................................................................... 84
EDITING THE DESIGN CL .................................................................................................................... 85

Appendix – Description of the Training Data .................................................................................... 86
Description: Introduction to 12d Model Data Setup
Level: Fundamental
Outcomes: After completing this module you should understand how to setup and Install the Training Data for the Basic Civil Design Course.

INSTALL TRAINING DATA

To install the Training Data, please download the data from the EXDS website via the following link:

The data set used in this training session is to be saved on the c:\ drive.

Once you have downloaded the zip file, open it and extract the files to the c:\drive, the training data will then be placed into the correct folders:
- C:\12d\10.00\EXDS_Training\12d-2C1_Basic_Civil_Design\12d-2C1_Basic_Civil_Design_Part_1
- C:\12d\10.00\EXDS_Training\12d-2C1_Basic_Civil_Design\12d-2C1_Basic_Civil_Design_Part_2
- C:\12d\10.00\EXDS_Training\12d-2C1_Basic_Civil_Design\12d-2C1_Basic_Civil_Design_Exercise

These folders above are referred to as the ‘Working Folders’ and will contain the 12d Model ‘Projects’.

The 12d Model data used in this training session is also located in the project folders:
- 12d Model - .12da file (12d ascii file)
- AutoCAD - .dwg file (drawing format)

All the files for this course are in 2 folders, as we will create 2 Projects in this training course.
These folders will be the ‘Working Folder’, for the new projects.
(Note: NOT all these files will be used in every course.)

Your folder may look slightly different, but the ‘Working Folders’ will be the “12d-2C1_Basic_Civil_Design_Part_1”, “12d-2C1_Basic_Civil_Design_Part_2” and “12d-2C1_Basic_Civil_Design_Exercise” Folders.

They contains the data set for this course, as well as where the 12d Model projects will be placed.
Description: The Big Picture – Road Design in 12d Model
Level: Fundamental
Outcomes: After completing this module you should understand the three (3) Basic parts of 12d Model to create a Road Design.

ROAD DESIGN IN 12D MODEL

Road design in 12d Model requires three basic parts to be prepared, and those three parts are then combined to form the design.

The three basic parts of the design are:

1. **A TRIANGULATION** (TIN) of the existing surface. This is created by triangulating the survey data.
2. **A DESIGN CROSS SECTION** – often called a Template.
3. **A CONTROL STRING**. Usually a Super Alignment string, it often represents the road centreline (but it doesn’t have to).

In 12d Model these three parts are combined using an APPLY function. When the APPLY function is run, cross sections are created (perpendicular to the control string) and stings are created parallel to the control string.
Description: Project Creation and Management
Level: Fundamental
Outcomes: After completing this module you should understand how to create a new Project how 12d Model stores Projects, and how to include Meta Data with your Project.

CREATE A NEW PROJECT

Double click on the desktop icon to start 12d Model.

12d Model will start, and show a list of the most recently used projects. We will not use any of the existing projects; instead we will create a new project.

To start a New project click on New

Type in a new project name. You should name your project Basic Civil Design

Click the yellow folder button to browse to the Basic Civil Design Part 1 folder on the C drive.

Press Create.
Description: Importing Survey Data into 12d Model

Level: Fundamental

Outcomes: After completing this module you should be able to import data into 12d Model, check the survey data for any crossing breaklines and then Triangulate it.

**NATURAL SURFACE TIN (TRIANGULATED IRREGULAR NETWORK)**

This section covers reading survey data into 12d Model, and triangulating it to form a TIN.

There are **six basic steps** to be taken in the creation of a TIN:

1. **Read** survey data into 12d Model
2. **Check** that the data is sensible – correct it if necessary
3. Check for **crossing breaklines** in the data
4. **Triangulate** the data to form a tin
5. **Null** any long triangles
6. **Check** that the tin is a good representation of the natural surface – add breaklines, or flip triangles if necessary
LOADING DATA – READING DATA INTO 12D MODEL

Data to create a tin (sometimes called a mesh, or a triangulation) can come from a variety of sources:

- 12d ascii (from 12d Model)
- Simple list of coordinates and elevations (x, y, z format)
- AutoCAD .dxf or .dwg (must be 3d)
- GENIO format (from MOSS or MX)
- CivilCAD (.as5)
- Microstation .dgn (must be 3d)

The data for this course comprises:

- 12d ascii data (Stage 1 Survey.12da)
- .dwg file for the cadastral (Stage 2 Existing Contours.dwg)

To load the Stage 1 survey data, use:

File I/O => Data Input =>12da/4da data.

Click the folder icon to bring up a list of 12da files in the Working Folder.

Choose the file to import into 12d Model.
You can double click, or you can pick it and press Select.

If the 12da file is not in the Working Folder, you can pick Browse to find the file on your system.
Add a Prefix to the Model names to control the data. survey(space)

When you have chosen the file, Press Read to import the file into 12d Model, then Finish to close the panel

Stage 1 Survey Data

Notes:

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
The second file to read into the Project is a DWG of the Contour Data for Stage 2.

To load the Stage 2 survey data, use:

File I/O => Data input => DWG/DXF/DXB

Click the folder icon to bring up a list of dwg files in the Working Folder.

Choose the file to import into 12d Model. Stage 2 Existing Contours.dwg
You can double click, or you can pick it and press Select.

If the dwg file is not in the Working Folder, you can pick Browse to find the file on your system.

When you have chosen the file, press Read to import the file into 12d Model, then Finish to close the panel.

All the survey data turned onto one Plan View.
The third file to read into the Project is a DWG of the Cadastral Data for Stage 1.

Click the folder icon to bring up a list of dwg files in the Working Folder.
Choose the file to import into 12d Model. Cadastral Stage 1.dwg
You can double click, or you can pick it and press Select.

When you have chosen the file, click Read to import the file into 12d Model, then Finish to close the panel.

The Cadastral Data loaded into 12d Model.
Description: Checking the Survey Data for Elevations, and Crossing Breaklines

Level: Fundamental

Outcomes: After completing this module you should be able to check the survey for the elevations of the data and that they are sensible, along with checking for crossing breaklines to ensure the data will be triangulated correctly.

CHECKING DATA

Regardless of the source of the data, you should check that the data is sensible before you use it. Validation is easy and quick, and could easily save you hours of rework in the future.

Three easy things to check:

1. Check that the elevations of the data are sensible.
2. Check that there are no crossing breaklines.
3. After the triangulation, check that the contours are sensible.

ELEVATIONS CHECK

To check the elevations of the data use:

Models => Model info table

Check that the minimum and maximum z values are all within a sensible range.

With levels of R.L. 0 and -99999, users would need to interrogate these models further.

There are two problems with this data.

1. Cadastral data has a height or RL. of 0 (zero)
2. Survey contours have null levels within the data. Eg. RL’s 0, -999, -9999 etc
These two problems should be fixed as follows;

1. None of the Cadastral data will be used in the creation of the triangulation. It is typical of Cadastral data that it will have no elevations or the elevations will be zero so don’t triangulate it.

2. The elevations of –99999 will be set to null so that they will be ignored by 12d Model. It would be possible to simply not use the Stage 2 Existing Contours model in the triangulation. Why is this not the best solution?

Notes:

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

To ensure that the points with an elevation of –99999 or 0 will not be used in the triangulation, the R.L. (Relative Level) of -99999 and 0 will be converted to null. In 12d Model points with an elevation of null will be ignored during the triangulation process.

NULLING HEIGHTS

To set a known level to null, use: Utilities=>H-Z=>Null Heights=>Height Range

By selecting height values between 0.1 and –99999, this ensures the unwanted R.L.’s are removed from the survey data and the project.

Choose View
Pick the View with all the survey data turned on
Fill out the minimum and maximum Z values for the height range to be nulled
Pick the Target: Replace existing data
Press Null to set the height range to null Z values, then Finish to close the panel
So now checking the data again, use:  

**Models => Model info table**

We can see that the Minimum Z Value has been adjusted to remove the Null level range we Nulled.

---

### CHECKING BREAKLINES

The survey data should be checked for crossing breaklines, and any found should be corrected before the TIN is created.

This is required to highlight possible crossing strings (data) with different valid R.L.’s. Users can then select the correct strings to maintain in the triangulation to ensure the TIN correctly matches the existing surface profile.

Use:  

**Tins => Check Breaklines**

---

**Model Information Table**

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Read only</th>
<th>Loaded</th>
<th>Elements</th>
<th>User Points</th>
<th>Points</th>
<th>Min X</th>
<th>Min Y</th>
<th>Min Z</th>
<th>Max X</th>
<th>Max Y</th>
<th>Max Z</th>
<th>Ctrl</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadstral Stage 1</td>
<td>unknown</td>
<td>yes</td>
<td>144</td>
<td>616</td>
<td>616</td>
<td>212687.796</td>
<td>0</td>
<td>213088.27</td>
<td>611974.303</td>
<td>0</td>
<td>We</td>
<td></td>
</tr>
<tr>
<td>survey Drainage</td>
<td>unknown</td>
<td>yes</td>
<td>10</td>
<td>123</td>
<td>123</td>
<td>212691.917</td>
<td>611506.492</td>
<td>70.6</td>
<td>212823.158</td>
<td>611555.712</td>
<td>75</td>
<td>We</td>
</tr>
<tr>
<td>survey Features</td>
<td>unknown</td>
<td>yes</td>
<td>88</td>
<td>738</td>
<td>738</td>
<td>211808.714</td>
<td>611498.712</td>
<td>72</td>
<td>213887.27</td>
<td>612495.966</td>
<td>94.55</td>
<td>We</td>
</tr>
<tr>
<td>survey Natural Surface</td>
<td>unknown</td>
<td>yes</td>
<td>18</td>
<td>1262</td>
<td>1262</td>
<td>211813.133</td>
<td>611501.133</td>
<td>70.903</td>
<td>213826.305</td>
<td>612255.214</td>
<td>94.447</td>
<td>We</td>
</tr>
<tr>
<td>survey Roads</td>
<td>unknown</td>
<td>yes</td>
<td>32</td>
<td>2130</td>
<td>2130</td>
<td>212102.394</td>
<td>612501.202</td>
<td>73.093</td>
<td>213174.61</td>
<td>612237.369</td>
<td>94.625</td>
<td>We</td>
</tr>
<tr>
<td>survey Stage 2 Existing Cont.</td>
<td>unknown</td>
<td>yes</td>
<td>1.52</td>
<td>6773</td>
<td>6773</td>
<td>211350.776</td>
<td>611779.535</td>
<td>68</td>
<td>213296.286</td>
<td>613495.315</td>
<td>93.5</td>
<td>We</td>
</tr>
</tbody>
</table>

---

**Check Breaklines, Duplicate Vertices and Identical Strings for**

- **Data set 1**
  - **View**
  - **Data set 2**
  - **Model**
  - **Models for**
    - **Intersecting strings with valid heights**
      - **Duplicate vertices of different heights**
      - **Identical strings in detail**
    - **Report File**
      - **Report type**
        - **12d Report Format**
      - **Report file**
    - **Self check strings**
    - **Colour for intersections**
      - **dark blue**
    - **Clean models beforehand**
    - **Simple crosses**

---

- Make sure all of the survey data has been added to View 1, and then choose this view as Data set 1.
- Adding models to a view, then choosing that view as the Dataset is a convenient way to select a group of models.
- Type in the name of a new (temporary) model. 12d will create this model and use it to store the results of the Check Breaklines operation.
- Views are used often 12d Model to select data. It is a lot easier to add the required data to a view and select that view in a panel, than choose a model or model list.
- Press the **Check** button to check the crossing breaklines.
If NO intersecting diamonds can be seen on a view when added, Check the “temp” model via the
Models => Models Info menu.

If no elements exist within the model, then the data has no crossing breaklines and is free of such errors.
For more information on Breaklines refer to the 12d-1A Introduction to 12d Part 1 course notes.
Zero Elements are shown for the temp model, and no strings are displayed in the String Information Table,
so it is safe to say there are no crossing breaklines.

Notes:
Description: Triangulating the Survey Data for an Existing Surface TIN, Editing the TIN and Nulling Triangles

Level: Fundamental

Outcomes: After completing this module you should be able to create a Triangulation of the Survey Data for an Existing Surface TIN. Edit the TIN and Null Triangles.

CREATE A TIN (TRIANGULATED IRREGULAR NETWORK)

A “Triangulated Irregular Network” (TIN) is used to find interpolated elevations at any location on the site.

Use:  
Tins => Create => Triangulate Data

General Tab

Type in a New tin Name we will use survey (tin name must be unique), then press the Enter key

The Model name for the new tin will be filled out once the Enter key is pressed.

Copy the Model name tin survey to the Retriangulate function option

The additional settings for Triangulations:

Preserve strings
Means that the strings in the project will be used as Breaklines in the triangulation, always ticked as a default.
**Remove Bubbles**

This will remove any flat areas created in the tins. Used mainly when triangulating contour strings, it means that a triangle will not be created with the three points connected to the same string.

**Triangle Data**

Is used when triangulating a set of triangle mesh data, this will also turn on the Weed Tin which will only use 1 point where there are multiple points at the one location.

This setting will NOT be used with the survey data.

**Cell Method**

Is used for really large data sets, in the background 12d Model will split the data set into smaller sections and enable it to process faster, but this doesn’t work at it’s best until the triangulation reaches 1 million points.

This setting will NOT be used with the survey data.
**Data Tab**

Nulling by Angle & Length can be completed within the Triangulate a Data Source Panel.

Choose View

Select View 1, all of the data we wish to use is on View 1.

The minimum and maximum Z values are shown for the data that is to be triangulated – a good check!

**Nulling Tab**

To activate the Nulling Tab tick on Apply Nulling

12d Model default values that can be modified, experiment with different length values. Eg 10m and 50m

If you have a Polygon surrounding the area to Null then you can select the string here

Press Triangulate to create the Tin
EDITING THE TIN

Once the Triangulation is created 12d Model automatically changes the Create Triangulate Panel to the Edit Retriangulate Panel, the View Data is changed to a Model List for future reference.

You are able to edit a tin at any time, use: Tins => Edit => Tin

Turn our new Model tin survey onto the plan view to display the Tin.

View Data has been changed into a Model List for future Reference.
NULLING TRIANGLES BY POINTS

Before we go any further with this tin, we will null (remove) the unnecessary triangles from the Triangulation.

Use:  

**Tins >> Null >> by points**

This option allows single triangles to be nulled (removed) from the triangulation.

Select the Tin from where the triangles are to be nulled.

Select with a Cursor Snap in the centre of the triangle to be nulled, and Accept the Pick to Null the Triangle.

The selected triangle has been nulled, and removed from the Triangulation.

When 12d Model Nulls the Triangles they are not deleted, they are merely turned off.

The Nulling can be continued until all the triangles have been nulled as required.
RESTTING TRIANGLES THAT HAVE BEEN NULLED

The Null Triangles by Points Panel will also enable you to **Reset** any triangles that have been Nulled from the Triangulation.

**Before the Triangle is Reset.**

Select with a Cursor Snap in the centre of the nulled triangle, and **Accept** the Pick to **Reset** the Triangle.

**After the Triangle is Reset.**

The triangle, has been **Reset**.
NULLING TRIANGLES BY STRINGS

This option allows multiple triangles to be nulled (removed) from the triangulation at a time.

Use:  **Tins => Null => by strings**

Select the survey tin to be nulled.

Right click on the String Option.

Select the Line option to draw a line through the triangles to be nulled.

Select the Polyline option to draw a squiggly line through the triangles to be nulled.

To increase the speed if this panel

Tick on Null on accept of strings.

This means you do not have to press the set button for every null.

Warning: there is no Undo.

(But you can RESET the triangles – see previous page)

**The Line Option**

Hold the Left button down and drag the line through the triangles to null.

Once the line is drawn press the **Set** button to Null the triangles.

If you wish to speed up the Nulling process, tick Null on accept of String, you do not have to press Set every time you

**The Polyline Option**

Hold the Left button down and drag the polyline around and across the triangles to null.

Once the polyline is drawn press the **Set** button to Null the triangles.
ADD A BOUNDARY AROUND THE TIN

When the unacceptable triangles around the edges of the tin have been nulled, we can create a boundary around the tin. The boundary will save the settings completed by strings or by points, to be saved if the triangulation has to be retriangulated.

Use: \textbf{Tins $\Rightarrow$ Boundary}

You are able to edit a tin at any time, use: \textbf{Tins $\Rightarrow$ Edit $\Rightarrow$ Tin}

The Tin Boundary can then be used in the Retriangulate Tin Panel, by selecting it as the Null Polygon, when retriangulating the Tin.

All the nulling is completed to the selected boundary.
Description: Creating a Design Cross Section – Template
Level: Fundamental
Outcomes: After completing this module you should be able to create a Design Template for a Road Design Cross Section.

TYPICAL CROSS SECTION FOR A ROAD DESIGN

The second part of Road Design in 12d Model is the creation of the Design Cross Section, or Template. As will be discussed in-line with Appendix A – Geometric Road Design. The Cross Section is the Vertical plane at right angles to the longitudinal road axis.

The Cross Section has a number of features including, Traffic Lanes, Shoulder and Verge areas, Table Drains and Cut or Fill Batter (interface) slopes.

The Traffic lanes provide adequate space for travel, the number is usually determined by AADT volumes and the lane width affects the roads capacity for traffic.

The Shoulder is provided for safety, allowing some wandering (recovery), emergency stopping and protection of the edge of pavement.

Typical Cross sections are produced on all projects to show the selected elements to be constructed, widths, and slopes and cross falls to be adopted and pavement depths for construction.

A typical road cross section is shown below.
CREATING A TEMPLATE – CROSS SECTION FOR A ROAD DESIGN

The template is created using: **Design => Templates => Create/Edit.**

![Image of the template creation process]

There are **four parts** to the template:

1. **Fixed.** This part is fixed by the designer (you!). This part of the cross section will not change for the length of the road. It is FIXED.

   After 12d Model completes the Fixed part of the cross section, it checks to see whether the last point on the fixed part (the shoulder in this case) is in Cut or Fill. If it is in FILL at the edge of the shoulder, then 12d Model goes to the FILL part of the template. If the shoulder point is in CUT, 12d Model goes to the CUT part of the template.

   It is okay to leave the CUT and the FILL parts of the template blank. 12d Model will automatically move to the Final Cut/Fill part of the template.

2. **Cut.** These instructions are carried out only if the last point on the fixed part of the cross section is in CUT. In this case the instructions are for the creation of a table drain.

3. **Fill.** These instructions are carried out only if the last point on the fixed part of the cross section is in FILL. In this case the instructions are for the creation of a verge.

4. **Final Cut/Fill.** After 12d Model completes any instructions in the CUT or the FILL parts of the template, it tests to see if the last point on the cross section (either the verge point or the table drain 2 point in this case) is in CUT or FILL, then carries out the instructions in the ‘Final Cut/Fill’ part of the template.
CREATE THE FIXED PART OF THE TEMPLATE

Type in the template name **Rural**

Press the **Fixed** button to display the Fixed Template panel.

Type in the template values for the design cross section.

The **Draw** button allows users to have the fixed part of the template displayed, and you are able to check the link values that have been entered.

Press **Apply** to save the Fixed template values.

Press **Draw** to refresh the diagram of the design links.

Press **Finish** to exit and finish the panel without saving.

Press **OK** to save and finish the panel.

**Notes:**

1. The level of each point is calculated based on the crossfall or height and is measured from the previous point.
2. Positive (+ve) height or xfall is up, negative (-ve) is down.
3. You can define the level of each point by height OR crossfall **BUT NOT BOTH.**
CREATE THE CUT PART OF THE TEMPLATE

Press the Cut button to display the Variable Cut Template panel.

Type in the template values for the design cross section.

Press Apply to save the Cut template values.
Press Draw to refresh the diagram of the design links.
Press Finish to exit and finish the panel without saving.

The Cut part of the template will be joined to the last link in the fixed part of the template which is the SH – Shoulder string.

Note:
This part of the template will only be used if the last point on the FIXED part of the template is in CUT.

Notes:
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
CREATE THE FILL PART OF THE TEMPLATE

Press the Fill button to display the Variable Fixed Template panel.

Type in the template values for the design cross section.

Press Apply to save the Fill template values.

Press Draw to refresh the diagram of the design links.

Press Finish to exit and finish the panel without saving.

The Fill part of the template will be joined to the last link in the fixed part of the template which is the SH – Shoulder string.

Notes:
1. This part of the template will only be used if the last point on the fixed part of the template is in FILL.
2. A slope of 1 in 25 is equal to 4%

Notes:
CREATE THE FINAL CUT / FILL PART OF THE TEMPLATE

Press the Final Cut/Fill button to display the Variable Fixed Template panel.

Type in the template values for the design cross section.

Press Apply to save the Final Cut / Fill template values. Press Finish to exit and finish the panel without saving.

Notes:

3. The **Final cut slope** will be created after the last point on the FIXED part of the template, and any links created in the CUT or FILL parts.

4. The **Final fill slope** will be created after the last point on the FIXED part of the template, and any links created in the CUT or FILL parts.

5. The fill slope is given as a positive number, despite the fact that it is sloping downwards.

6. The maximum slope width is the maximum distance that 12d Model will look/search for the natural surface tin. If the tin is not found after 100m, 12d Model will stop looking, and create the int point at the last template string.

7. The name of the interface string will be int.
Description: Creating a Control String – The Road Centreline

Level: Fundamental

Outcomes: After completing this module you should be able to create a Design Control String using a Super Alignment String, creating the Horizontal and Vertical Geometry.

THE CONTROL STRING

The Control String is the third and final part of the elements required to create a road design in 12d Model. (The three parts being the tin, design cross section and control string.)

The process described in these notes can be used for any type of string, but a Super Alignment String is the best type of string to use for Road Design Control String.

The Super Alignment String is special. The Horizontal and Vertical Geometry are independent, and tangency is maintained between elements.

This means that:

- The Horizontal Intersection Points (HIP’s) have no elevation. You cannot assign an elevation to a point in the View plan. The horizontal shape of the road is determined by the HIPs and the horizontal curves.
  
  Note: The grades and vertical curves of the road cannot be designed in the Plan View.

- The Vertical Intersection Points (VIP’s) have no x, y location. The vertical shape of the road is determined by the VIPs and the vertical curves.
  
  Note: You cannot determine the plan location of the road with the VIPs.

- Horizontal curves and vertical curves must be tangential to the adjacent straights.

The Horizontal and Vertical designs are linked by Chainage. At every chainage on the horizontal geometry, the elevation of the road is defined by the Vertical geometry at that chainage.

Another way of thinking about the Super Alignment String is that it is a string that must be designed twice. First you design the Horizontal geometry of the string in a Plan view, and then you design the Vertical geometry in a Section view.

CREATE A SUPER ALIGNMENT STRING

Use: Strings => Create => Super Alignments => Super Alignment
OPENING THE SUPER ALIGNMENT TOOLBAR

Use: View => Toolbars

All 12d Model toolbars are available in this menu in alphabetical order.

A specific toolbar has been created for the Super Alignment and is the easiest way to create, edit and control a super alignment strings within a project. It is called **Super Alignment Tools**

Many designers will place this toolbar at the top of the screen as it is so often used.

CREATE A SUPER ALIGNMENT

Fill out the General Information.

Type in the Road CL name – this will be the label for the Road for Long Section plots.

Type in the name of the Centreline Model.
Select the Label Style from the drop down list.

Select an Alignment Style from the list.

Press Create to open the Super Alignment Editor.
Press Many to open the Super Alignment Editor. When the editor is saved and closed the Create Super Alignment panel will be opened again to create the next Super Alignment.
Press Same As to go to pick and accept another Super Alignment and load the properties of the selected string into the create panel.
Press Finish to close the panel without creating a Super Alignment.

THE SUPER ALIGNMENT EDITOR

After selecting Create and the Super Alignment Edit Bar is created for each individual Super Alignment.
Note: If you were to have more than one Super Alignment string being edited at any one time. The number two (2) etc would appear in the bar heading.

The Model name and String name of the Super Alignment
THE SUPER ALIGNMENT EDITOR – IP METHOD

Add / Remove IP Options

The first set of icons relate to the IP method of design. They can be obtained by holding the left mouse button down; this will display the Add/Remove options. Which then allows you to place Intersection Points both Horizontally and Vertically, using the following commands.

Note: Where HIP options are shown, they relate only to Horizontal Intersection points (Plan information), Where VIP options are shown, they only relate to Vertical Intersection points (section view)

- **Append HIP** - Horizontal Intersection Point.
- **Append VIP** - Vertical Intersection Point.
- **Insert IP** - between existing IP’s both horizontal and vertically.
- **Between IP** - inserts additional IP but maintains the current horizontal bearing (for HIPs) or vertical grade (for VIPs).
- **Insert VIP Height** - places a VIP to a determined height.
- **Insert VIP Grade** - enables you to place a new VIP at a Grade and distance.
- **Intersect VIP Grades** - enables you to intersect two VIP’s by entering grades.
- **Filter IP’s** – removes Horizontal and Vertical Intersection points not required for geometric definition.
- **Delete** - enables you to delete Horizontal and Vertical IP points.
Change IP Options

Move IP – enables you to move Horizontal and Vertical IP points by the curser.

Move Horizontal Parts – this dialog box will appear, with which you are able to nominate HIP numbers to move (if you leave the Start and End Parts blank the whole alignment will move), the horizontal plane in which to move the IP’s.

Eg. X or Y and the value you wish to move the parts by.

Move Vertical Parts – similarly, this dialog box will appear, with which you are able to move Vertical IP points in a section.

Note: By placing the same IP number for both Start and End part of a move, you are able to move individual IP’s both Horizontally and Vertically.
Extend – The extend will work differently in the Horizontal and Vertical design. If used in the Horizontal Design the Straight selected will be extended with a set bearing, the proceeding or following straight will have its bearing altered only. Similarly in the Vertical plane when selected on one grade, this is set and extended and the proceeding or following grade will change accordingly. When selecting the Straight or Grade to extend click and accept on the straight or grade on the side of the intersection point you wish to maintain, then click and accept on the new location for the HIP or VIP.

Extend By Length – The Extend By Length will allow you to extend a HIP or VIP by a given length either with a Forward or Backwards distance from the selected Intersection Point. Select the Straight or Grade you wish to maintain as detailed above and then type in the length to extend the intersection point by.

Tangent Wizard – The tangent wizard will increase (both Horizontally & Vertically) the length of a curve, so as to produce a back-to-back tangent. The IP selected (with an existing curve) will increase until the TP point from a nearest curve is reached, producing back to back curves.

Move Tangent – Can be used for both Horizontal and Vertical curves, users are able to select TP locations and can slide curves and parabolas, back and forth as needed. This will change the radius of the curve when used in the Horizontal & the Parabola length in the Vertical.

Change Curve – To be used to place both Horizontal and Vertical curves to an alignment. Horizontally it will place a curve at a nominated radius. Vertically it will place a curve (parabola) by length nominated. If an IP point has no curve 12d Model determines the radius or length to be 0 (zero).

Change Height – The Change Height option operates on VIP points in the section view. You are able to select a VIP point, its known Z value can then be amended in the Height panel provided.

Change Grade – By selecting on a known grade within the section, we are able to adjust the grade via typed input. This amendment will change the grade from the VIP to the left of the selection and amend the Z value of the next VIP point to the right, this will also change the proceeding grade in the process.

Change Grade 2 – As per the above Change Grade, this option will also allow you to input a required grade, but will maintain the proceeding grade as set by you. It effectively extends the proceeding set grade, adjusting the VIP point both by Chainage and Z value until it can calculate your desired Grade nominated.
The Remaining Super Alignment Editor Icons

- **Add / Remove IP Options** – Options detailed above.

- **Change IP Options** – Options detailed above.
The Remaining Super Alignment Editor Icons

Add / Remove IP Options – Options detailed above.

Change IP Options – Options detailed above.

The Change – button will allow the user to change different parts of the Super Alignment string. The parts that can be changed are the radius of a horizontal curve, the length of a vertical curve, the bearing of a horizontal straight or the grade of a vertical grade.

Part Editors – Options detailed below.

String Properties – will allow users to change the original string properties entered by the user, including the name, colour, chainage labeling and start chainage of the string just to name a few.

The Undo/Redo – options for the Super Alignment string currently being edited by this edit bar. It is important that users use these buttons and not the Edit => Undo option from the main menu. The menu option will undo other operations, prior to the user opening the String Edit bar.

Info – button provides an information panel that displays the details of the alignment.

Recalc – recalculates the Super Alignment string. Mostly used for advanced operations.

Error Checker – will display where there is any part of the Super Alignment that is not solving.
Clear Horizontal Alignment – will delete all the horizontal design information of your design.

Clear Vertical Alignment – will delete all the vertical design information of your design.

Help – will open the 12d Model Help Document.

Finish option – the string is checked for overlapping horizontal or vertical tangent points and any errors are reported to the user to be corrected. But if there are no errors to report the Super Alignment will be saved and the editor closed.

Quit option – the string edit commands are terminated and any changes made to the string at that time will be lost.
**Part Properties** – will show users the Horizontal and Vertical Parts in a Tree format and is used to provide Element based design geometry for advanced users. This will be covered in the 12d-2C2 Intermediate Civil Design Course.

**HIPs Editor** – provides a panel for entering, editing and verifying the Horizontal I.P. geometry.

**VIPs Editor** – provides a panel for entering, editing and verifying the Vertical I.P. geometry.

**Chainage Equalities Editor** – provides a panel for entering, editing and verifying the Rail Chainages.

**Custom Editor**

**Centreline Options** provides a panel for entering, editing and verifying the Centreline Options. A place to have different options for both Horizontal and Vertical Designs.

**Named Positions** provides a panel for entering, editing and verifying the Named Positions that have been created for the Super Alignment.
THE SUPER ALIGNMENT TOOLBAR

To access the Super Alignment Toolbar, use: View => Toolbars

- Edit a Super Alignment
- Create a Super Alignment
- Information Panel
- Report for a Super Alignment
- Resolve a Super Alignment
- Fixed/Floating to IP Method
- Deref a Super Alignment
- Reverse a Super Alignment
- Parallel a Super Alignment
- Translate a Super Alignment
- Rotate a Super Alignment
- Scale a Super Alignment
- Split a Super Alignment
- Join a Super Alignment
- Copy Vertical Design
- Change Label Style
- Explode Labels
- Move Settings for Super Alignment
- Label Style Editor
- Tabulate a Super Alignment
- Tabulate IP’s for a Super Alignment
- Help for a Super Alignment
THE SUPER ALIGNMENT EDITOR – HORIZONTAL DESIGN

Freehand Straights

The Super Alignment Editor will be used to create HIPs (Horizontal Intersection Points) to define the plan position of the straight parts of the Alignment, and then create curves at the bends (HIP's).

To create new HIPs for the road centreline, from the Editor, use Append HIP.

To create the road, select a position on the plan View for a series of HIPs, by clicking and accepting (with the middle button).

Locate a road alignment freehand roughly as shown.

Horizontally, there are five basic commands that it is important to be confident with.

These are:
- Append
- Insert
- Delete
- Move
- Extend

Make sure that you are confident using these commands, before you place curves on the alignment.
Horizontal Curves

On the SA Editor, select Change Curve, to place curves at the HIPs.

Select and accept one of the HIPs - the existing radius will be displayed.

Note: 12d Model has the radius of the curve set to (0) zero even before we add/change a curve to the HIP.

Type a new radius for the curve then press Enter to create the curve.
Notes:

1. We strongly recommend that you use a linestyle of ‘1’ for the Alignment string. If you use any other linestyle, the CS and SC points will not display properly.

2. You can still move the HIPs in the same way as before, and you can also move the TPs (tangent points). Note: Moving the TPs will change the radius of the curve.

3. You can change the radius of the curve in the same way that you created the curve: remember that the curve is associated with the HIP.

Spirals (also known as Transitions or Plan Transitions)

Spirals are added to the TPs (tangent points), where the curves join the straights.

To place spirals onto a curve, we must first open the HIPs Editor panel and select the IP (Curve radius) where the spirals are required.

When the Curve radius cell is highlighted blue, use your right mouse button and select the Curve Spiral option.

When the HIP Type has been changed to Curve Spiral type in the Leading and Trailing Spiral lengths you require on the curve. Select Set and then Finish on this panel.
Horizontal Geometry – Life in the Real World

There are three ways to locate the HIPs on an Alignment:

1. Freehand / typed coordinates.
2. By bearing and distance from a known point, or from the previous HIP.
3. By locating HIPs in relation to other points, such as cadastral boundaries, existing trees, existing road centerlines, conservation areas, etc.

In the real world the last method is by far the most common.
Zoom in on the area of the survey roads model as shown.
Our proposed road centreline will be designed over the top of the existing road centerline.

By placing four Horizontal IP’s on the known existing straights, we will then have 12d Model calculate where these existing straights intersect.

Now turn off the survey Roads model to see the alignment easier.
Once the insert option has been started and the HIP is on your cursor, we need to have 12d Model calculate the intersect point of the two straights.

To calculate the intersection point of the 2 straights, first select the insert IP icon from the SA Edit panel.

Then pick the segment where the HIP insert is to go. (Between IP 2 & 3).

Select the Snaps Cad Intersect button from the Snaps Cad Toolbar.

Select the two known straights (with Direction) towards the intersection point.
Finish the Horizontal Geometry construction by Filter IP’s. This will remove the construction IP’s not need for the centreline.

With the straights defined, add an appropriate radius curve and spirals as outlined above. This will finish the Horizontal components and we will be ready to start on the important vertical geometry.

Notes:
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
THE SUPER ALIGNMENT EDITOR – VERTICAL DESIGN

Profile the Super Alignment String

Once the road centreline is located in Plan (by the Horizontal IPs) we can design the vertical geometry of the road. This is done in a Section View.

Use: View=>New=>Section to open a new Section View.

We will use this view to do the vertical design for this road.

The line that you see IS NOT THE SUPER ALIGNMENT STRING.

The Super Alignment String has no vertical geometry.

What you see is the natural surface along the route of the alignment string.
Appending VIP’s (Vertical Intersection Points)

Have you closed the String Editor bar for your Super Alignment after finishing the Horizontal geometry?

If you have, select F6 on your keyboard or use: **Strings => Editor** from the menu and select the Super alignment to activate it once more.

At any time, you are able to edit your design centreline with this Editor menu.

Select the **Append VIP** button and place VIP points along the section view working from **Left to Right**.

The first and last VIP point should match the existing tin levels to ensure a smooth tie into the existing levels.

Remember, it is very easy to move the VIPs at a later time.

VIP numbers must increase from **Left to Right**

When you have finished adding Vertical Intersection Points, right-click in the Section View, and click **Cancel**. This cancels the Append operation or press the etc key on your keyboard.
Vertical Parabolas can be added to Super Alignment using the Change Curve button and selecting a VIP point. The typed input panel will appear, enter the approximate length and move to the next VIP until all required parabolas have been added. If you prefer to design using K-Values, select the VIP Editor. Then change the Length to K-Value and add your required values. Press Set and Finish to save the changes.
Super Alignment Info Panel

By selecting the Info menu from the SA Edit bar will bring up the Super Alignment Info Panel.

By running your cursor over the vertical geometry. 12d Model will provide additional vertical information on your design including Crest and Sag K-Values, and Heights on the parabolas.
Refining the Vertical Design

The Super Alignment Editor is your Toolbox of tools to refine the Vertical Design.

Useful tools are:

- **Move**
- **Extend**
- **Vertical Curves can be changed using the Change Curve icon.**
- **If you want to change the grades to be specific numbers, use the Change Grade or Change Grade 2 icons.**

**Note:** Ensure to Check final grades and K Values are compliant with the projects design standards.
Description: Combining the TIN, Control String and Template in the APPLY Function

Level: Fundamental

Outcomes: After completing this module you should be able to create a Road Design using the Apply Function and creating the Road Strings and Cross Sections.

**APPLY PANEL**

The final step in the creation of a road design is to combine the tin, template and control string together to form the road design.

The results of this operation will be the creation of cross sections (perpendicular to the centreline) and strings (parallel to the centreline) of the road.

On the Main Menu, use:

**Design => Apply => Apply**

**Apply Panel – Main Tab**

This is the input panel. You must provide a Function name, Tin, Templates and a Reference string.

The Function name is important as it will be used as the naming convention for the model names, volume report, tin name etc.

This will occur when you enter the Function name (normally the name of The Super Alignment) then hit the Enter key.

The 12d Model programmers don’t like typing either!

12d Model will remember all of the parameters that you fill out on this panel. The name that you type in as the Function Name will be used to recall the parameters.
Type ROAD01 and press the Enter key, 12d Model will populate more of the panel for you with this name (Keeping the standard naming convention for the project).

This is where you specify the TIN that will be used. The tin was created earlier in this course - select survey.

The tin is used by 12d Model to create the interface lines (batters), and for the calculation of cut and fill volumes.

A Report of the cross sectional areas, incremental volumes, and cumulative volumes can be produced by typing a report name into this panel if you require.

Specify a template for the left hand side of the control string, and one for the right hand side. You may specify different templates, however for this course we will use the same template on both sides. The one we just created is Rural so select from list by clicking on the ABC Icons.

Click on the arrow beside the Reference panel then click and accept the road centreline string (i.e. the reference string) – the centreline string name will be displayed in the panel.
**Apply Panel – Models Tab**

Models are created to contain your Road Strings, Sections and Polygon models.

These Models are automatically filled out when after you type the Function name and press Enter.

---

**Note:**

The Apply Function will create sections perpendicular to the control line, and road strings parallel to the control line. These strings and sections will be saved into the models that you specify in the Models Tab. DO NOT use an existing; instead you should type in a new model name.

It would be a mistake to save the new cross sections into the same model as the existing survey data. If you have already pressed Enter after typing in the Function name, the model names will have been automatically populated, if not type in a new model name for the strings and sections – **ROAD 01 Strings and ROAD 01 Sections.**
Apply Panel – Misc Tab

The functions in the miscellaneous tab are well described in 12d Model Help.

EXDS recommends the use of **Super arcs** created as part of the Apply.

**Arrows**

When 12d Model created the strings parallel to the control line, these strings can be:

- **no arcs** – a 3d string (straight) will be drawn between each cross section
- **alignment arcs** – alignment strings (curved strings) will be drawn between the cross sections
- **polyline arcs** – polylines (curves) will be drawn between each cross section
- **super arcs** – super strings will be drawn between each cross section

So what to choose? That depends on how you plan to use the strings.

**3d Strings** (no arcs) are the simplest case, and if you do not intend to plot the strings, then this is the quickest and most simple choice.

**Alignment** strings (alignment arcs) are special strings, which have independent horizontal and vertical geometry. (Remember the road centreline that was created earlier). If you intend to manually edit the strings at a later time, then alignment strings are the best choice. Otherwise they are not the best choice.

**Polylines** are similar to 3d strings, but with the added advantage of having curves as well as straights. In most cases, Polyline arcs are the best choice.

**Super arcs** are very similar to polyline arcs, but can do so much more. If you want to add annotation to the strings, or change the colour of individual segments, then choose super arcs. **We recommend that you use super arcs.**
Apply Panel – Tin Tab

With a tick of a Box, we are able to produce a TIN of the design automatically.

Triangles are Nulled to the Interface Polygon and colour applied to the tin, via the corresponding Polygon colours, helping produce quick and effective visualization models of the project to be viewed in Perspective.

Depth Range Polygons (*.drf) are also produced with a tick of the box. These help designers quickly identify areas of excess Cut or Fill and so speed up the design process to produce a balanced design.

Standard Depth Range files can be downloaded from our website. www.exds.com.au

Save these into your User_Lib directory and access them on all projects via the yellow folder. Walk right on the User_Lib menu to show the list of files.
Apply Panel – Filter Tab

By ticking on the Filter Cross Sections Tab, enables designers to remove additional cross sections to produce a copy for Cross Section plotting for presentation.

12d Model takes the model of design sections and copies the cross sections that match the criteria on the Filter Tab. These cross sections are then copied to the Filtered Sections Model.

The Filtered Sections interval must be a multiple of the original design sections created on the Main Tab.

eg. 10, 20, 30, 40 etc

If you require cross sections at 15m intervals for plotting, then make the original design sections every 5m.

Apply Panel – Plot Tab

Users are now able to automatically generate and update Longitudinal and Cross Sections plots with this tab.

Standard plot parameter files (ppf’s) are able to be loaded and then output the plots to a variety of plotter types.

The plot file stem in this panel will be used in place of any stem specified within the ppf file.

Detailed plotting information is covered in another section of this training manual.
Create the Design

Once the Apply panel has been filled out it needs to be Run to create the strings and sections for the design.

Was the Apply Successful?

If the Apply was successful, earthwork volumes will be displayed. Congratulations.
If the Apply DOES NOT work properly, a message will display in the panel instead of earthwork volumes:

The Function was created BUT the **Apply FAILED** – no Volumes reported.

**The reason**: The Reference string was not selected.

The Function was created and the **Apply** was successful BUT – no Volumes reported.

**The reason**: The existing tin was not selected.

If the Apply was Successful **ADD** your new models to the plan view to have a closer look at the design.
WHAT IS HAPPENING – UNDERSTANDING THE APPLY FUNCTION

Understanding how 12d Model creates the road is important, not for this course, but in the more advanced design techniques.

**Cross Sections** are created according to the template, perpendicular to the reference string (or the hinge string if this is specified) with a point for each link in the template.

**Cross Sections** have a piece of text assigned to each of the points created from the template link names as shown here.

Finally 12d Model **joins the dots** to create the strings parallel to the reference string.
**Description:** 12d Model Perspective View and driving down the road

**Level:** Fundamental

**Outcomes:** After completing this module you should be able to create a Perspective View and turn on the Road Design strings and Sections. Then set the settings for driving along the Road Design.

### CREATE THE PERSPECTIVE VIEW

To create a perspective view use: **View => New => Perspective**

Add the Road Strings and the Road Sections to the Perspective View and click the Drive button on the Perspective View menu.

Select the String to drive along, being the Centreline.

Press the Drive Button to start the Drive.

Driving along the Road
Description: Plan Plotting

Level: Fundamental

Outcomes: After completing this module you should be able to create a Perspective View and turn on the Road Design strings and Sections. Then set the settings for driving along the Road Design.

ADDITIONAL PLAN INFORMATION TO CREATE

The following examples are some additional information you may wish to produce to place on your plan presentation drawings.

TADPOLES / BATTER SLOPE LINES

You may wish to create batter slope lines or tadpoles on your plan to indicate to others where areas of cut and fill exist along the edge of your design.

This process can easily be run, use: Strings => Labels => Cut / Fill => Tadpoles, Ticks or User Symbols

The three (3) panels all work the same way; we will show the Tadpoles as the example.

If you do not enter Start and End Chainages, the Tadpoles will be created along the whole length of the design.

The small and large tick percentage is the size of the tadpoles between the two (2) batter strings.

The Interval is the distance between the tadpoles

Type in a new Model Name.

Select the
- Reference String (Super Alignment),
- String 1 (eg Top of Batter),
- String 2 (eg Interface String)
Press **Tick** to create the Batter Tadpoles.

To create the Batter Tadpoles on both sides of the Road, select the Reference String, String 1 and String 2 on the second side of the Road and press **Tick**. The Tadpoles will appear.

**Use:**  **Strings => Labels => Cut / Fill => Ticks**

Use the **Ticks Panel** to create the Tick marks which shows the batter slopes for plan presentation.

**Use:**  **Strings => Labels => Cut / Fill => User Symbols**

Use the **User Symbols Panel** to create Batter symbol marks, which shows the batter slopes for plan presentation. The symbol can be any different type of symbol that you wish to create.
LABEL CENTRELINE CHAINAGES

You may wish to place chainage label text and ticks to your centreline, matching your long section information.

To Label a Model of Centrelines, use: **Strings => Label => Chainages**

- **Select the Model of Centrelines**
- **Select the Label Mode** – regular interval (plus end pts)
- Type in a **ch interval**
- **Type in a Model for labels**
- **Select a Textstyle** for the Chainages
  - Add a **Pre*postfix for Labels** = CH
  - Add **# decimal places for labels** = 3

- Press **Label** to create the Centreline Chainages, then Press Finish

- **Type in a Model for labels**
- **Select the Mode for marks**
- Type a **Size for marks**
- Select a **Colour for marks**

- Press **Label** to create the Centreline Chainages, then Press Finish
To Label a single Centrelines but setup a function, use:

**Strings => Label => Chainages (function)**

1. Type in the **Function Name**
2. Select the **String to Label**
3. Select the **Label Mode** – Horizontal TPs
4. Type in a **Model for labels**
5. Select a **Textstyle** for the Chainages
6. Add a **Pre*postfix for Labels** = TP
7. Add # decimal places for labels = 3
8. Type in a **Model for labels**
9. Select the **Mode for marks**
10. Type a **Size for marks**
11. Select a **Colour for marks**
12. Press **Label** to create the Centreline Chainages, then Press Finish.
The created Chainages for the Design Centreline are ready to be exported to a CAD program or plotted from 12d Model.

Notes:
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
CENTRELINE GEOMETRY SETOUT INFORMATION – TABULATION

12d Model can provide users with many different styles of setout information for geometry to place on our drawings and provide to the surveyor. Many options can be found under the Report menu, we suggest you try a number of options until you find your desired standard or follow the example below.

The Tabulation is a Function, allowing users to quickly re-run if the road geometry was to change during the life of the project.

Examples below use the Super Alignment toolbar options.

Tabulation

Type in a **Function Name**
Select the **Super Alignment**
Select the **Geometry mode**

Type the **No. of Decimals**

Select the **Type of Geometry**
Type in a **Model Name**
Select a **Location** on the Screen
Select a **Colour** for the Table
Select **Textstyles** for the Title, Header and Data for the Table

Press the **Process Button** to create the Setout Table.
Press the **Finish Button** to close the panel.
CENTRELINE GEOMETRY SETOUT INFORMATION – TABULATE IPS

The Tabulate IPs is a Function, allowing users to quickly re-run if the road geometry was to change during the life of the project. This option places geometry information on the Alignment, showing the IP, Bearing & Radius information etc.

Users are able to move the text and boxes to better positions and tick the box to maintain that location if the geometry was to update.

Examples below use the Super Alignment toolbar options.

**Tabulate IPs**

- Type in a **Function Name**
- Type in a **Model Name**
- Select a **Colour** for the Boxes
- Select a **Textstyle** for the Boxes
- Select to **Draw Tangents**
- Select the **Reference String**
- Press the **Process Button** to create the IP Tables
Press the **Move Table Button** to move the IP Tables around the plan view.

**Notes:**

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
QUICK SHEET PLOT

Plan plotting is almost always done from a Plan View.

Press the **Plot Button**

Select the **Quick Sheet Plot** Option

Select a **Plotter Type** – Model will send the plot to a new model (Type in a Plot File name – this will be the new model name)

Type in a **Scale** for the Plot

Select the **Sheet Size**

Press **Plot** to create the new model
Press \( \text{ } \) to relocate the plot by the origin point.

Press \( \text{ } \) to relocate the plot by the centre point and rotate the sheet to fit the data to the plan.

Locate the Sheet around the data on the plan view, then press the Plot Button to create the Plan Plot.
COORDINATED CADD PLAN OUTPUT – AUTOCAD

For plan information, which you intend to place into a CADD package for presentation, again a Plan view of the information required is the easiest way to output the information. Export of the information via these menus will ensure the data remains coordinated with other project information. (NOTE: This cannot be guaranteed with Architectural drawings).

To export the design data to DWG, use:

File I/O => Data Output =>DWG/DXF/DXB => . DWG/DXF/DXB

Type in and select the options required to export to a DWG file.

For DWG Output, users are able to load a Template file containing standard layers, colours and linestyles to a company standard. This feature greatly increases the company’s productivity and helps maintain an office consistency.

For help with this customisation, contact the EXDS Support line on (02) 9453 9449.

Press the Write Button to create the DWG exported file.
COORDINATED CADD PLAN OUTPUT – MICROSTATON

For plan information, which you intend to place into a CADD package for presentation, again a Plan view of the information required is the easiest way to output the information. Export of the information via these menus will ensure the data remains coordinated with other project information. (NOTE: This cannot be guaranteed with Architectural drawings).

To export the design data to DGN, use:
- File I/O => Data Output => DGN => . DGN V8
- OR
- File I/O => Data Output => DGN => . DGN V7

Select the **View** Option

Select the **View** with the Design Data

Type in and select the options required to export to a DGN file.

Press the **Write Button** to create the DGN exported file.

For DGN Output, users are able to load a **Template file or Seed File** containing standard layers, colours and linestyles to a company standard.

This feature greatly increases the company’s productivity and helps maintain an office consistency.

For help with this customisation, contact the EXDS Support line on (02) 9453 9449.

Press the **Write Button** to create the DGN exported file.
Description: Long Section Plotting  
Level: Fundamental  
Outcomes: After completing this module you should understand how to setup and create Longitudinal Section Plots from 12d Model.

LONG SECTION PLOTTING

The long section ppf editor is for creating and / or editing a (binary) long section ppf file and for creating a long section plot.

Once you have profiled your centreline in a section view, click on the plot button then Long Plot to display the Section Long Plot PPF Editor panel.

1. Select the button, walk right on the User Lib, and double click on the parameter file = EXDS_A1_Long_Plot.lplotppf
2. Press the Read Button
3. Select the View button and select the relevant Section View.
4. Make Selections
5. Change the parameter file name to a new name = **Road 01 LS.lplotppf**

**Note:** Highlight the whole file name and directory, then type in the new filename.

6. Press the **Write Button** – this saves the new Long section PPF file in the Project’s Working Folder.

**WARNING:** Failure to change the filename BEFORE clicking the Write Button, will result in overwriting the parameter file in the User Library!!

7. Press the **Plot Button**.

In this case, it will create a Model called = **Plot A1 LS Road**

(Note: If a plotter / printer was selected as the Plotter Type, it would start printing.)

8. Press **Finish** to close the editor.
To create long section plots of your design, click on the **Section Long Plot** to expand the display. Some sections expand again for further selection.

Below identifies the relevant sections from the Section Long Plot Editor.
Change Design Surface
Select:  

Boxes => Primary String Titles / Heights

At Title Line 1, type: **PROPOSED DESIGN**
At Title Line 2, type: **ELEVATIONS**

Change Tin Title (Natural Surface)
Select:  

Boxes => Tin Titles / Heights / Depths => Titles

At First Line of Tin Title, type: **NATURAL**
At Second Line of Tin Title, type: **SURFACE**
**Change Chainage Title / Values**

Select: **Boxes => Chainage Title / Values**

At Title Line 1, type: **PEGGED CL**

**Change chainage Interval**

Select: **Chainage / Staggering**

Delete 10 and type 20.
Datum Area

Select: Datum Area

Datum Line gap to top of boxes (mm)
Type in 20 and plot the changes.

Datum Line Gap – now 20mm
Primary String Title
Tin Title
Chainage Title
Chainage Interval = 20m

Notes:

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
Description: Cross Section Plotting

Level: Fundamental

Outcomes: After completing this module you should understand how to setup and create Cross Section Plots from 12d Model.

CROSS SECTION PLOTTING

The cross section ppf editor is for creating and / or editing a (binary) cross section ppf file and for creating cross section plots.

Once you have profiled a cross section in a section view, click on the plot button then X Plot to display the Section X Plot PPF Editor panel.

1. Select the button, walk right on the User Lib, and double click on the parameter file = EXDS_A1_Cross_Plot.xplotppf
2. Press the Read Button
3. Select the View button and select the relevant Section View.
4. Make Selections
5. Change the parameter file name to a new name = Road 01 XS.xplotppf  
   **Note:** Highlight the whole file name and directory, then type in the new filename.

6. Press the **Write Button** – this saves the new Cross section PPF file in the Project’s Working Folder.  
   **WARNING:** Failure to change the filename BEFORE clicking the Write Button, will result in overwriting the parameter file in the User Library!!

7. Press the **Plot Button**.  
   In this case, it will create a Model called = Plot A1 XS Road  
   (Note: If a plotter / printer was selected as the Plotter Type, it would start printing.)

8. Press **Finish** to close the editor.
**Description:** Final Design Changes

**Level:** Fundamental

**Outcomes:** After completing this module you should understand how to adjust final design changes and then plot out of 12d Model.

**FINAL DESIGN CHANGES**

Now you have created Long and Cross Section PPF files specifically for your design Road 01.

You may want to open the Apply Function and load the PPF files into the Plotting Tab.

 Tick to **Generate Long-section plots**
 Select the **Long-section PPF file**
 Select the **Plotter type**

 Tick to **Generate Cross-section plots**
 Select the **Cross-section PPF file**
 Select the **Plotter type**

 Press **Apply** to run the whole road design again and plot the Long and Cross section plots again!

 Press **Finish** to close the panel.

While the original PPF files may have been set to a plotter Type of model (to view plots in 12d).

The plotter type selected here will overwrite the original plotter.
EDITING THE DESIGN CL

To edit the Horizontal or Vertical geometry for Road 01, select one of these options:

OR….

Use the **F6 Button** on your keyboard to access the String Editor.

OR….

The Edit option on the Super Alignment Toolbar will only select Super Alignment strings.

Make some Vertical alignment changes and select the **Apply Button** again. All your old Road 01 Strings, Sections, Tin, Depths, Long Section and Cross Section Plotting will be deleted and re-created to your new geometry.

**How Fast is that!**
## Appendix – Description of the Training Data

<table>
<thead>
<tr>
<th>Create “Basic Civil Design” Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load EXDS Standard Project Details information for plotting Long &amp; Cross Sections later on.</td>
</tr>
<tr>
<td>Import <a href="#">Stage 1 Survey.12da</a> &amp; <a href="#">Stage 2 Existing Contours.dwg</a> files.</td>
</tr>
<tr>
<td>Import <a href="#">Cadastral Stage 1.dwg</a>.</td>
</tr>
<tr>
<td>Checking survey data, <strong>Elevations</strong>, and <strong>Nulling Heights</strong></td>
</tr>
<tr>
<td><strong>Check Breaklines</strong> on the survey data before creating the tin.</td>
</tr>
<tr>
<td><strong>Triangulate</strong> the survey data, editing the Tin, <strong>Nulling Triangles</strong>, adding a <strong>Boundary</strong> to the Tin.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Template Creation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start the <strong>PowerPoint Presentation (PPP)</strong> and work through the Theories of the Road Design Cross Section (<strong>PPP Sections 1 &amp; 2</strong>).</td>
</tr>
<tr>
<td><strong>Create a Template</strong> (Rural Road) and look at all the Template options, including the file in notepad.</td>
</tr>
<tr>
<td><strong>Create a Second</strong> Template for an Urban Road Section.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Design CL Creation – Super Alignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import “<strong>Survey.dxf</strong>” file.</td>
</tr>
<tr>
<td>Check <strong>Crossing Breaklines</strong> in the survey data.</td>
</tr>
<tr>
<td>Create a <strong>Triangulation</strong> called tin survey and <strong>Null</strong> the long triangles.</td>
</tr>
<tr>
<td>Create a <strong>tin boundary</strong>.</td>
</tr>
<tr>
<td>Use the tin toggles to view the tin toggle options, <strong>tin contours</strong>, <strong>tin flow</strong> and <strong>tin solid</strong>.</td>
</tr>
<tr>
<td><strong>Create Contour Strings</strong>.</td>
</tr>
<tr>
<td><strong>Export</strong> survey data and contour strings to AutoCAD.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Exercise No. 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Triangulation and Contour Strings</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>String Creation &amp; Modification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Line</strong>, and <strong>Line Strings</strong>.</td>
</tr>
<tr>
<td><strong>Move points</strong>, insert points, extending points and add points between points.</td>
</tr>
<tr>
<td><strong>Add points</strong> with exact coordinates, and bearing and distances.</td>
</tr>
<tr>
<td><strong>Pick with Direction</strong></td>
</tr>
<tr>
<td><strong>Adjust string height with the F2 Button</strong>.</td>
</tr>
<tr>
<td><strong>String Parallel</strong>, <strong>String Join</strong>, and <strong>Join Many</strong>.</td>
</tr>
</tbody>
</table>
Tin Analysis

- Slope Analysis Inquiring.
- Create Slope Analysis data of the Barwon Data Triangulation.
- Exporting Slope Analysis Results.
- Tabulate Range File – Creating a Legend.
- Aspect Analysis - Creating.

Exercise No. 2 – Building Pad

- Open the “Barwon” Project again.
- Create Building Pad outline.
- Interface Function to create the Cut and Fill Batters to the Natural Surface Tin.
- Adjust the height of the string (F2 Button).
- Re-run the Interface Function.
- Add Corner Angle in the Project Defaults.
- Create new Plan View and Add the 3 Design Pad Models.
- Triangulate the Design Pad.
- Open a Perspective View & turn on the NS tin, Design Pad tin & the Design Pad Models.
- Open a Section View, draft a line through the Design Pad and Profile the 2 tins.

Exercise No. 3 – Water Quality Basin

- Open the “Barwon” Project again.
- Import the Basin Floor strings – basin floor.12da.
- Interface Function to create the Cut and Fill Batters to the Natural Surface Tin.
- Adjust the height of the string (F2 Button).
- Re-run the Interface Function.
- Add Corner Angle in the Project Defaults.
- Create new Plan View and Add the 3 Design Pad Models.
- Triangulate the Design Pad.
- Open a Perspective View & turn on the NS tin, Design Pad tin & the Design Pad Models.
- Open a Section View, draft a line through the Design Pad and Profile the 2 tins.